Quick Start Guide

Installation of Box into car

There are three harness that come with the control box that must be installed into the car; two six pin connectors
that go from the box controller to the electric shocks and travel sensors (not included and optional) and an eight-pin
connector that connects the shock box controller to the rest of the vehicle.

Wiring From Electric Box
8-pin Connector

Red disconnect switch. Do NOT connect to the ignition switch.
Black . . . . .
Connect to ground. Either a good chassis ground, of directly to the battery negative (-) terminal.
White Left bump valve output (Rated 3 amp load continuous to ground).
Gray Right bump valve output (Rated 3 amp load continuous to ground).
Li Burnout wire. This wire enables the burnout function when connected to 12 volts (more details
ight Blue
below).
Bt e Launch wire. Selects rebound position 1 and enables the timer to run. (When activating through a
clutch switch, 12 volts must be applied during staging, then removed enable the timer to run as
shown in Figure 2. When using a WOT switch, 12 volts must be a
6-Pin Connector - Right Shock / Sensor
Red/Green 12 volts to the Koni Shock input.
Black Ground to the Koni Shock input.
Green Control signal to the Koni Shock input.
Pink Shock position potentiometer +5 volt signal input.
Brown Ground to the shock position potentiometer.
Brown/Green |Shock position potentiometer wiper.
6-Pin Connector - Left Shock / Sensor
Red/Green 12 volts to the Koni Shock input.
Black Ground to the Koni Shock input.
Green Control signal to the Koni Shock input.
Pink Shock position potentiometer +5 volt signal input.
Brown Ground to the shock position potentiometer.
Brown/Orange |Shock position potentiometer wiper.

8-pin Connector

Power Wire

It is recommend to connect the Red power wire to the main battery disconnect switch - NOT to the ignition switch.
The power to the system must remain on during the burnout and run. If the power is switched on then off, such as
off a three-position switch, the burnout mode must again be activated for the timers to work.

Burnout

The Burnout wire (Light Blue) should be enabled during the burnout by switching it to 12 volts and then be switched
off prior to staging the car. This will set (or reset) the bump and rebound timers and stop and reset the data
acquisition. This wire must be switched on then off to reset and arm the system! This includes when the system is
first powered up. This can be wired in series to other switches that are already activated by the crew or driver such
as data acquisition systems, line-locks or any trigger before the launch wire is activated.




Launch Wire

The Launch input (Dark Blue) can be programmed to begin the launch timer with the release of the clutch, using a
clutch switch (or trans-brake) or upon activation of a WOT switch. This can be programmed from the menu under
Laun, LaunClutch or LaunWot in Graphview which is covered later in this document. Examples of these are given
later in this document.

Left and Right Bump Controllers

If the shocks being used do not have air sweeps installed on the shocks, these can be tied-up and away as these
will not be utilized. For vehicles that have this installed, these two wires are used to send a grounding signal to the
air controller to activate it. If both shocks are being activated at the same time, only one input needs to be used.
On two-stage systems, the Left or the Right wire can be used for the first stage while the Right can be used for the
second.

Examples of Launch Wire installations

Clutch Switch: The Launch wire, Dark Blue, should be switched through the clutch pedal switch. When 12 volts
are supplied to the Dark Blue wire, the system prepares to start the timer. When the 12 volts are removed (the car
launches) the timer begins running and the data acquisition begins recording up to 20 seconds of data. Note that
the burnout switch must not be active. See Figure 2.

Note: This may need prior approval by NHRA to connect this unit in this manner because of the single wire
connecting to the clutch switch rule. Use of a second clutch switch or WOT switch is an option.
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Figure 2: Wiring a Launch/Burnout through the Clutch Switch.

Wide Open Throttle Switch: Figure 3 shows how to use a WOT switch to activate the timer. The timer begins
when 12 volts are applied to the Dark Blue wire. The Burnout switch should remain closed connecting 12 volts to
the light blue wire until the car is ready to be staged.

Note: A clutch switch can be wired in series with the WOT switch to act as a safeguard from accidentally setting
the timer off.



Quick Start Quide

Installing and Using the Pro-Data+ Software

Installation of Software
1. Insert CD into drive.
2. If installation program does not automatically load, please do the following;
a. Click the Start button and select Run
b. In the box, type D:\autorun.exe
c. Hit OK button or enter.
3. When the install screen below comes up, click the button CLICK HERE TO INSTALL VERSION 3.12.

4 MSD Ignition Pro-Data+ Software
CK HEf

 MSD
PRO‘DATEE

SOFTWRRE
I KONI
FOR USE WITH:

PROGRAMMABLE
SHOCK CONTROLLER
with data acquisition

.\-I\ SOFTWRRE

FOR USE ON WINDOWS 9X, ME, NT, XP AND 2000. WWW.MSDIGNITION.COM

Please note that updates (if available) can be found by clicking to the right of the arrow on the upper black stripe.
4. Follow the On-Screen Instructions.

5. At this point there should be two MSD icons on your desktop.
6. Select the one that says MSD Graph View. This will open the Pro-Data+ software.

Using Pro-Data+ Software

1. Connect the 9-pin cable to a computer and to the KONI shock controller. It is recommended that the power to
the KONI shock controller be turned on at this time as well to upload any changes that may be made. The power
can be turned on after the program has been started as well.

2. Open the MSD GraphView software. When opened, the screen will open with one or several windows on
screen. If the computer program is started with the KONI shock controller system off, the GraphView window
(typically in the upper left of the screen) will have the area under the MONITORS section blank. When turned on,
the monitors will show real-time parameters and readings that it is seeing from the KONI shock controller.

3. When the program is opened for the first time, the program file for the KONI shock controller must be loaded.
This can be done by the following;
a. In the upper left corner of the screen select File, Open.
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b. Select the folder 1290001.

c. Select the file that says 1290001vXX.IGN (XX means
the latest version such as 02).

d. Click on Open



The Graphview program can now be used to setup the KONI shock controller.

4. With the KONI shock controller on, the initial setup of the system can be started. First, go to the GraphView
window (in the upper left corner of the screen) and select View from the pull down menu. Please make sure that
the options Tree (in lower left below) and Shock Rebound Curve (lower right below) are open. Launch
History (upper right) can also be selected in this menu which allows you to view any data acquisition that you
may have saved on previous runs with the KONI shock controller though is not necessary on the initial setup.
With all three of these mentioned windows opened, your screen will look like this;
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5. At this point, the Pro-Data+ software is ready for the setup of the KONI shock controller. Because of the many
options associated with this system, a sample setup will be done. A more detailed look at each of these windows

will be covered separately to go over their features.

Walkthrough of an Initial Setup of the Electric Box

This example is starting with the system hooked up and powered on with the screen as shown above.

1. On the Tree (lower left) box, set the following;

a. Laun - LaunClutch (for a Clutch/Trans-Brake setup, LaunWOT for WOT switch) A window will pop
up that gives a toggle switch to choose between these options. Chose the setup for your system and

select the Save to PC button when finished.

b. Test > Test PwrOn (will cycle test the shocks on power-up to test for problems). There are also
options to test the shocks when the Burnout mode is activated (Teat BurnOn) or for both (Test

Pwr+Burn).

The Optional Bump Control settings can also be setup here. OnDelay sets the delay before the ground signal is

sent after the Launch while the OnTime controls how long this signal is on.

2. In the Shock Rebound Curve window (lower right)

a. If the window is not already open, go to the GraphView window and select View - Shock Rebound

Curve. The Shock Rebound Curve window will now open.




b. A graph will appear in the lower right section of the computer screen with time going across left to right
and shock adjustment positions 1 (softest) to 4 (firmest) along the vertical axis. A solid line along position
one will be on the graph with a dot at the 0.00,1 position on the graph.
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c. To setup the initial starting point for the shocks when the car is in the Launch mode, first click on the
point at (0.00, 1). The coordinate of the dot will then appear on the screen as shown above. Now move
the dot by clicking and dragging (moving the mouse while holding the left mouse button down) the dot to
your initial starting point (for most vehicles, position (0.00, 4). A pink line will remain on the position 1
setting while a black line will move while you drag the mouse to your initial setting. The black line is the
settings for the Left shock. The pink line is the setting for the right shock. For now, we are only
concerned about the Black line for the Left shock.

d. To add a dot, a change in rebound settings, can be done in one of two ways. The easiest method to do
this is to right click the mouse approximately where you want the dot and select the Add Dot option that
will appear in the pop-up menu. This will add a dot to the line that you currently have set as Active. A dot
can also be added by selecting the Edit > Add Dot option though this doesn’t always put the dot in a
good position. To move the dot around, click on the dot once to show its coordinates and then click and
drag to move.

If the dot is not exactly where it should be set, select View - Zoom In and the graph will automatically
zoom in on the selected dot and give you greater precision (to the 0.01 second) of when to switch the
shock setting. Continue to add dots at the different times that you want the shock to switch rebound
settings. For this example, add three dots at (2.00, 3), (3.00, 2) and (3.50, 1). Your setup can vary
from this example depending on the vehicle being used. The Shock Rebound Curve should now look
like this.

mshock Rebound Curve EDIT  11.94 Time 0 Rebound ZoomX=1.0 Zoom¥=1.0 - O x|
File Transfer Edit Miew Show  Active -
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e. When finished setting up one shock, this can be copied and pasted to make both rear shocks match.
This is done by selecting Edit 2 Copy Curve, then Active - Trace2 (or whichever Trace is not
currently checked) and finally Edit > Paste Curve. You have now setup both shocks to adjust at the
same time.



When finished go to the GraphView window (upper left) and select Transfer > PC to MSD. The power

to the KONI shock controller MUST be on for this option to be available. A new window will now pop up. Select
Tranfer All Data. The curve and settings will now transfer to the electric box and can be tested. To save the
curve for future editing, select File > Save As... and choose a new name for this setup. The initial file
1290001vXX.IGN (XX means the latest version such as 02) that was opened can not be saved over.

Initial Test

A test run of the system can now be preformed. For this initial test, leave the computer hooked on with the
GraphView program with the Shock Rebound Curve screen open.

1.

With the system hooked into the car with all switches hooked up, toggle the Burnout mode by switching on and
off the appropriate switch. In the GraphView window, the Monitor will show BurnSw ON when the switch has
been turned on and then will toggle to OFF.

When the launch switch is activated (determined by the LaunClutch or LaunWOT setting), the Monitor in the
GraphView window will show that the LaunchSw ON, the green TIMER ON LED will light on the KONI shock
controller and a red line will scroll across the Shock Rebound Curve window.

With the engine of the car off, the shock can be heard switching at the appropriate setting. If this does not
occur, check to make sure that the switch is being activated and that all wires are hooked in correctly. If there
are problems that the system detects, a pop-up window will appear on the computer screen and the
POWER/STATUS LED on the KONI shock controller will flash.

Alert codes

These codes will flash on the POWER/STATUS LED on the KONI shock controller only if there is a problem and
should warrant further investigation.

2 blinks - Over Voltage

3 blinks - Shock Short

4 blinks - AllShock Open

5 blinks - LeftShock Test

6 blinks - RightShock Test

7 blinks - Acq Memory



Details of Options Available on the GraphView and Data Editor Windows of the

GraphView Software

GraphView Window (upper left)

This is the main selection window of the program. From here, the other windows required for the program can be
opened from the View pull down menu. The MONITORS part of the window will allow you to see real-time data
that is being taken from the KONI shock controller. The pull-down menu options are as follows.

File

Open Opens settings profile for an MSD box. Initially, you will only open the file 1290001vXX.IGN (XX is
the version number).

Save Saves the current profile you are working on under the same file name. The 1290001vXX.IGN file
can not be saved over.

Save As... Saves the current profile under a new name.

Send To... Sends the file to a drive or other device.

Exit Closes the Pro-Data+ program.

Transfer

MSD to PC Qplogds the current profile from the connected KONI shock controller to the PC for editing for
viewing.

HODLLED) Downloads the current profile from the PC to the KONI shock controller.

Verify Checks for differences between the PC and the MSD profiles.

Convert PC to MSD

Downloads the current profile from the PC to the KONI shock controller.

View

Restore Opens all previously opened windows.

Dial Not used on the 1290001 Shock controller box.

Tree Opens the Data Editor window to setup the Burnout, Launch and Bump settings.
Alert Opens the alert window. This will automatically pop up when an error is found.
Notes Opens text box to enter notes about the current profile.

Shock Rebound Curve

Opens window to setup the Shock Rebound Curve.

Launch History

Opens the window for looking at data acquisition from the box.

History File 1 Opens a data acquisition box for comparing two runs.
Port
[Comi -9 | Allows you to select the COM port that the Shock Controller box is connected to.
Help
Help Pops up the help screen with further instructions.
About Information screen that give the release version of the program.
The monitor values are shown below.
Monitor Sample Value Description
Scan Time 1Sec used for the 7550 Handheld to set the display scan rate
displays the output status for Shock power. Will not change when system is turned off but
ShockPwr Off-ON "PrzdL)cht Conne?:ted" box above monFi>tors will switch to Nc?ne. !
ShockCur 0.03 Shock current in amps total current draw of both shocks.
LeftPos 255 Left shock position sensor data 0-255 value.”
RightPos 255 Right shock position sensor data 0-255 value.”
LtPosInch 25.5 Left shock position sensor in inches.*
RtPosInch 25.5 Right shock position sensor in inches.*
LtRebound 4 Left shock rebound valve position 1-4.
RtRebound 4 Rightshock rebound valve position 1-4.
LtBumpCtl OFF-ON Left Shock Bump control valve position. Will only change to ON during run.
RtBumpCtl OFF-ON Right Shock Bump control valve position. Will only change to ON during run.
LaunSec 20.00 Timer seconds elapsed .01 to 20.0 seconds.
BurnSw OFF-ON Burnout switch status.
LaunchSw OFF-ON Launch switch status.
Test PwrOn Test mode enabled status. See Data Editor for more information.
Acq OFF for 1290001 data acquisition status. See Data Editor for more information.

* - Values will not change without a position sensor connected.



Data Editor

The Data Editor window can be selected by going to the View pull down menu and selecting Tree if this window is
not already open. If there is a check mark already next to Tree, then the window is already open.

The Data Editor window will typically be in the lower left corner of the screen. This is where setup changes for all
but the rebound curve are made. The options on this Screen are as follows.

Monitor
Stats
Stat 1
Rebound
Rebound
Burn
BurnRebound
Left

Right

Left
Right

Bump
BumpControl

Left
OnDelay 1.00

OnTime 1.00

Right
OnDelay 1.00

OnTime 1.00
Laun

Launch
LaunClutch

Scale
LtPotLen 8.0

RtPotLen 8.0

Acq
AcqENA

Sec 6.0

See Monitor list help.

Only used by the 7550 hand held terminal

Left Shock rebound position when Burnout switch is only active. User adjustable from 1 to
4 discrete positions.

Right Shock rebound position when Burnout switch is only active. User adjustable from 1
to 4 discrete positions.

Values in this table can only be edited in the Shock Rebound Curve in GraphView

Values in this table can only be edited in the Shock Rebound Curve in GraphView

(where system in installed on electric shocks)
Independent Bump Control outputs for driving solenoid electric air valves to operate the
Bump valve on each shock after the launch.

Sets the delay time to TURN ON the Bump valve position for the left solenoid. User
adjustable from 0.01 to 20 sec in 0.01 increments.

The total ON time of the Bump valve position for the left solenoid. User adjustable from
0.01 to 20 sec in 0.01 increments.

Sets the delay time to TURN ON the Bump valve position for the right solenoid. User
adjustable from 0.01 to 20 sec in 0.01 increments.

The total ON time of the Bump valve position for the right solenoid. User adjustable from
0.01 to 20 sec in 0.01 increments.

Launch input programmable modes to begin the launch timer with the release of the clutch,
using a clutch switch or upon activation of a WOT (Wide Open Throttle) switch. User
adjustable as LaunClutch or LaunWOT.

Left position potentiometer calibration value in inches used for calibrating the optional
position sensors. The position sensors are calibrated to full scale input 0 to 5 volts for full
travel of the position sensor. See Section “Calibration of Position Sensors” in help
documentation for more information. User adjustable from 0.1 to 25.5 inches.

Right position potentiometer calibration value in inches used for calibrating the position
sensors. The position sensors are calibrated to full scale input 0 to 5 volts for full travel of
the position sensor. See Section “Calibration of Position Sensors” in help documentation
for more information. User adjustable from 0.1 to 25.5 inches.

Only when 1290001 Shock Controller is being used for Data Acquisition

If set to AcQENA a record of up to 12 sec will be recorded. If set to AcqOFF, no record will
be recorded. User Adjustable to AcqENA or AcqOFF.

Total time in seconds for the duration of a record. Data is recorded at a sample rate of
1000 samples per second. The record will begin collecting data depending upon which
launch input mode (Laun) is selected. LaunClutch will start recording data when the clutch
is released and the Burnoff switch is OFF. LaunWOT will start the recording when the
WOT switch is activated and the Burn Switch is OFF. User adjustable from 0 to 12.0
seconds in 0.1 increments.



Test
Test
Test Off Test sequencing for Power ON, Burnout Test, Power ON and Burnout Test or Testing
OFF. Testing takes about 1.6 seconds to complete. The purpose of this test is to test the
overall condition and functionality of the shock system.

Alerts Alerts are display messages that can be allowed to momentarily interrupt the current
display screen on the 7550 hand held terminal and pop up windows on the PC Screen if
using GraphView.

Alerts 1 Only used by the 7550 hand held terminal
(1) Over Voltage

(2) Shock Short

(3) AllShock Open

(4) LeftShock Test

(5) RightShock Test

(6) Acq Memory

The Power/Status LED will flash a Blink Code on the KONI shock controller for each active Alert.
The 1st Alert in the list will blink 2 times
The 2nd Alert in the list will blink 3 times
The 3rd Alert in the list will blink 4 times
The 4th Alert in the list will blink 5 times
The 5th Alert in the list will blink 6 times
The 6th Alert in the list will blink 7 times



